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1 General 
  
 
SetEditDVB2000 is a program to change the settings (program sequence, names of channels etc.) of 
the Nokia 9200/9500/960x digital satellite receivers running on DVB2000. 
 
You can easily make your own channel lists, edit them, print them and write them into your receiver. 
You can enter new channels, edit, delete and save them, change the names of channels, sort, search, 
copy and paste channels. 
 
With SetEdit you can edit settings of different receivers, exchange channels between settings files of 
different receivers or convert a settings file of one format into another (e.g. SetEditDVB2000 into 
SetEditSatcoDX). If you have other receivers you can add new "modules". 
 
The settings are read from the receiver and written into the receiver via the RS232 interface with a null 
modem cable or via the SCSI port with an SCSI cable. 
 
With this program you can also change the receiver firmware, if you already have a DVB2000 on your 
receiver. 
 
In the following guide you will find a step by step description of how to use this program. In the other 
chapters there is a short description of all functions divided in file, channel, label, transponder and 
favourite list functions and the configuration. 
 



  
2 Installation 
  
 
System requirements: 
PC with Windows 95/98/ME/NT/2000/XP, one free serial port and 20 MB of free disc space. 
If you want to use SCSI, you need of course a SCSI adapter and on your PC has to be a generic ASPI 
driver. For additional information please take a look at the manual of your SCSI card. 
 
If you like to install SetEdit for the first time, please start the file SetEditDVB2000_installation_en.exe. 
 

 
 
In this window you can select, if you get in addition to the program a desktop shortcut and an entry in 
the start menu. Furthermore you can select that after the installation SetEdit is launched and/or the 
SetEdit directory is shown in the explorer. 
When you click on "Next", you can select the installation directory. 
 
The installation contains the program itself, some pictures and a sample settings file. 
 
If you want to add other SetEdit versions, please copy the file "SetEditXXX.dll" in the SetEdit directory 
you already have. 
In your SetEdit directory, you will now find the DLLs that are the modules for the different receiver 
types. 
 
There are no changes made to the Windows system files. 
 
You will also find the file SetEditDVB2000.ini in this directory. Your personal configuration is saved in 
this file. 
 
To uninstall SetEditDVB2000 simply delete all these files. 
 
If you have more than one receiver (with the right DLL modules), you can decide with which type of 
SetEdit the program should start. You just have to change the name of the exe file. Example: If you 
start SetEditDVB2000.exe after the installation of SetEditDVB2000_installation_en.exe the program 
will start as a DVB2000 editor. If you change the name of the SetEditDVB2000.exe file into 
SetEditLyngsat.exe, the program will start as Lyngsat editor. Of course you can open additional 
SetEditDVB2000 if required. 
 



  
3 Step by step 
  
 
I assume that the program has been installed on your PC as described in chapter 2. 
Also it is assumed that you are using SetEditDVB2000 for the first time. In the following I will describe 
how to transfer the settings from the receiver to the PC and back (chapter 3.a and 3.g). By means of 
examples you will see how to get order in your settings (chapter 3.b), how to use the label functions 
(chapter 3.c), how to put channels into the favourite list (chapter 3.d), how to work with the 
transponder menu (chapter 3.i), how to enter new channels by hand (chapter 3.i), how to handle the 
peculiarities of German Premiere World channels (Formula 1, soccer, pay-per-view) (chapter 3.i) how 
to adjust settings from other sources to your requirements (chapter 3.j and 3.k) and how to convert 
one settings format into another (chapter 3.k). 
 
  
3.a Load and back up a settings file 
  
 
Please connect your receiver to the PC with a serial null modem cable (no 1:1 cable) or with an SCSI 
cable. 
 
If you start SetEditDVB2000 for the very first time you will get a window with the history of the changes 
from previous versions. 
 

 
 
The first thing you should do is to make a backup of the channel settings in your receiver. You can 
restore such a backup at any time into your receiver and the receiver will be the same as it was at the 
time you made the backup. 
 
To do this, you have to enter in the configuration your software version and the comport you have 
used to connect your receiver to the PC. Please click on the button "Config." 
You will get the following dialogue: 
 

 
 
(Here you find three pages. If you are on the page "Colours" or "Convert", please click on "General 
settings" to get the menu shown above.) 
 
Please enter in the box "Comport" the correct comport and in the field "Receiver" your software 
version. 
 
If you want to use SCSI, you first have to activate this function in your receiver. Please press on your 
remote control Menu -> 8 (Setup) -> 4 (SCSI). As default you can try the following setup that works 
with most of the SCSI cards: 3 detect: on; 4 act. neg. off; 5 glitch: 12 ns and 8 Com-Dev. In 6 "Box ID" 
you enter a free SCSI ID. Usually the ID 0 is reserved for the controller and you can't take this ID. If 



you don't have other devices like SCSI hard disc or SCSI CD Rom connected to your PC, you can 
choose the ID as you like; otherwise you have to take a free one. Perhaps you have to let your PC 
search for new hardware before the receiver is detected. 
 
In the section "Baud rate" you enter the speed for the serial communication (only if you use RS232). 
To find out the serial communication speed (baud rate) you need for your receiver, please press on 
your remote control -> Menu -> 9 (Expert Menu) -> A (General Setup). On the Nokia remote control A 
is equivalent to the button "Menu". You find the serial communication speed on menu item 6. This is 
the value you have to enter in the configuration of SetEditDVB2000 in the box "baud rate". 
 
Note: SetEditDVB2000 does not support all baud rates of DVB2000. 
 
When you have entered these parameters, please click on "OK". 
 
All other options of this menu are explained in chapter 5.b in details. 
 
Now click on the button "file". You will get the following menu: 
 

 
 
Here you select the function "Backup", you get the following window: 
 

 
 
In this window you enter the directory and the filename for your backup. (Note: the language of this 
window depends on your windows version, so don't worry if you see German buttons here.) 
As soon as you have clicked on "save", the following message will appear: 
 

 
 
When you have clicked on "OK" in this message, the settings will be read from the receiver and saved 
on your hard disc. 
 
Note: In the DVB2000 the channel settings and the general receiver settings (e.g. LNB configuration, 
DiSEqC settings, receiver menu settings, etc.) are saved separately. To save the general receiver 
settings to, you have to click on the button "File" and then on "General settings". In the window you 
see now you click on "File" again and then on "Read from the receiver". With "File" -> "Save" or "Save 
as" you can save your general settings now. For more details see chapter 5.a. 
 
If you make some unintentional changes in your settings when you experiment with SetEditDVB2000 
you can always restore this backup file into your receiver and reverse any changes. 
 
Now it depends on whether you want to change your own receiver settings with this program or if you 
want to adapt a settings file that you found on the Internet to your own requirements and write it into 



your receiver (chapter 3.j or 3.k). 
 
If you want to change your own receiver settings please click on the button "File" and select the menu 
item "Read from receiver". You get the same message you know from the backup function, so 
continue as described above. 
 
The settings are now transferred from the receiver to the PC, but this time the settings are not saved, 
but shown in SetEditDVB2000. 
 
If you want to adapt settings that you found in the Internet to your own requirements and then write 
them into your receiver, you have to load these settings first. Please click on the button "File", and 
then select the function "open" from the file menu. 
Now please select the file you want to load from the list you see 
 

 
 
and click on "Open" or double click on the file you want to load. 
 
Note: If you want to write settings that you have found in the Internet into your receiver, you have to be 
careful: 
For each channel the DiSEqC and 0/12 V settings etc. are saved too, these may not be the settings 
you need for your antenna. In chapter 3.k or 5.d you find how to adjust these settings to your 
requirements. 
 
When you have loaded a settings file or read the settings from your receiver, you get the following 
window (depending on the window size and some personal settings the picture may differ). 
 

 
 
You see the TV channels (light blue background), radio channels (light green background) and the 
data channels (grey background) as well as a transponder list, a label list and the favourite list (FAV). 
 
For DVB2000 settings please note: 
The receiver supports in addition to TV (light blue background) and radio channels (light green 
background) other types of channels too (e.g. data channels, NVOD, etc.). These channels are shown 
in both channel lists with white background colour; i.e. in the TV list are all channels which are no radio 
channels, and in the radio list are all channels which are no TV channels. The receiver uses the 
"labels" for the navigation in the channel list. Labels are channels with the frequency 0 on which you 
can jump directly with your remote control (semicircular arrow buttons left and right). So in the label list 
you will find all channels with the frequency 0. If you adjust such a label to the type "TV" or "Radio" it 
will only be shown in the chosen channel list, as data channel it will appear in both channel lists. A 
label of the type "TV" is shown with light blue background colour in the label list, a label of the type 
"radio" or "TV + Radio" will also get the corresponding background colour. All channels between two 



labels belong to the first of these labels. If there are no channels between two labels, the first of these 
labels has no channels; it is empty and is marked in the label list with red background colour. 
 
If you select an item in the label list, you will see all channels and all transponders that are assigned to 
this label. 
 
If you select a transponder or the favourite list, you will only see the channels that are assigned to this 
transponder or the favourite list. 
 
When you select a channel, label, transponder and FAV list (if the channel is in the FAV list) of this 
channel are marked grey. 
 
Channels that are in the favourite list are marked in the channel list with a darker background colour. 
 
Labels marked in red are empty; they contain no channels. 
 
If the channel number is marked with a red background colour, the channel is assigned to a vertical 
polarised transponder. If the channel number has a white background colour, the channel is assigned 
to a horizontal polarised transponder. 
 
(You can change all these marking colours in the configuration menu, see chapter 5.b.) 
 
Note: In the DVB2000 the channel lists can be shown in two ways: separated in TV and radio 
channels or all channels together in one list. If you use the separated viewing mode in the DVB2000 
(Menu -> 9 -> A -A 9 -> 5 Radio Mode: 2) this corresponds to the picture shown above. If you use 
Radio Mode: 1 (only one list) you should perhaps use the same viewing mode in SetEditDVB2000 too. 
To change the viewing mode please click with the right mouse button in the channel list and select 
Show -> mixed. Now the TV and radio channels are shown in a mixed list and not separated in a TV 
and a radio list. 
 
When you click with the right mouse button in the channel list (TV or radio) and select from the popup 
menu the entry "Info" you will get the number of TV channels, radio channels, data channels and 
labels that are in your settings. 
 

 
 



  
3.b Arrange settings 
  
 
Now you have the settings (from your own receiver or from the Internet) in SetEditDVB2000. 
The most important functions will be explained now in detail with some examples, while in the chapter 
functions all functions are briefly described. 
 
The most important function of SetEditDVB2000 is to get order in your channel list. This can be by 
deleting channels you don't need (e.g. channels that are scrambled and you have no subscription for), 
getting the channels into a useful order, assigning the channels to the labels or the favourite list and 
correcting wrong channel settings (e.g. wrong channel names). 
 
First let us suppose that we want to delete a channel. To do this we have to select the channel first. 
Please click with the mouse on the channel. Then the label, the transponder and the FAV list (if this 
channel is in the FAV list) of this channel are marked grey in the respective list. 
Sometimes it is useful to change this colour (similarly for other colours, for example the colours used 
for new channels (for the import) or duplicate channels), e.g. because the colours are too pale on a 
laptop. You will find a description how to do this in chapter 5.b. 
 
Now click with the right mouse button in the channel list and open the channel menu: 
 

 
 
Please select the item "delete" in this menu and the selected channel will be deleted from your 
settings. 
If you delete a channel within the favourite list, this channel is only removed from the FAV list but not 
deleted from the main list. 
 
Note: There is no undo function yet, so be careful. 
 
To delete a channel, you can also select the channel and then hit the Del key on your keyboard. 
 
To delete multiple channels please click for example on channel 5, then press the shift key and keep it 
pressed and then click on channel 7. The channels 5 to 7 are now selected. Now you can delete these 
channels as described above. 
 
To select channels that are not consecutive (e.g. the channels 5, 20 and 39) please click on the first 
channel (here channel 5), then press the Ctrl key on your keyboard, keep this key pressed and then 
click on the other channels you like to delete. 
 
Now assume we want to move a channel, e.g. ZDF to position 2. 
 
Note: You can show your channel lists in original order or sorted by alphabet, frequency or polarity. 
Moving channels is easier when the channel list is shown in its original order. If the channel list is 
shown in alphabetical order and you move a channel, only the channel number will change but not the 
position of the channel in the channel list (the name is still the same). To show the channel list in 



original order, please click with the right mouse button into the channel list and select from the menu 
item "View sorted by" the option "Original". 
 

 
 
To change the viewing mode of the channel lists you can also click on the letters "O" (original), "N" 
(Name), "F" (frequency) or "P" (polarity) in the border of the channel lists. 
 
First we have to find out the position of the channel ZDF at the moment. To find all channels you first 
have to click on the label "All" to see really all channels, independent of the label the channels belong 
to. Then you can search for ZDF by entering the first letters of the channel name. Please click 
anywhere in the channel list and hit the "Z" key on your keyboard, now all channels whose names 
begin with "Z" are selected. Now hit the "D" key on your keyboard. Now all channels beginning with 
"ZD" are selected. You can do this of course with the third, fourth letter etc. If you wait for more than 
three seconds between two letters a new search is started, so that the last letter entered is taken as 
the first letter of the name that is searched. 
 
You can also use the "find channels" function to find channels by name. Open the channel menu and 
select the function "find channels" from this menu. You will get this window: 
 

 
 
You can choose whether you want to search on all labels or only on the actually selected labels. Click 
on the field beneath "All labels" to search on all labels. 
 
If you now enter "ZDF" in the field "Name" you will see in the list above all channels whose names 
begin with "zdf", e.g. the channel ZDFtheaterkanal. 
If you click on the white square to the left of the text "substring" you will see all channels that include 
the entered letters as a part of the channel name (beginning, middle or end, upper/lowercase is 
ignored). If you enter for example the word "sport" the channel "Eurosport" is found too. 
 
Now you can move channels from this list to another position in the channel list or assign them to 
another label, transponder or the favourite list. The channels will not be removed from the find list, but 
when you click on such a channel you will see that the new label, transponder or the favourite list is 
now marked in grey. 
 
Within this find function you can also delete channels. Simply select the channel in the list of the find 
function and hit the Delete key on your keyboard. 
 
Now you have found for example ZDF. There are several ways to move the channel. 
 
The first way is to move the channel by drag & drop: click with the left mouse button on the channel 
you want to move, keep the mouse button pressed and drag the channel to the position you like to 
have it. The channel will be placed in front of the position the mouse is on. 
To drag a channel on the last position in the list, you have to drag it behind the last channel. 
 
You can also move the channels with the arrow keys of your keyboard. Please select the channel(s) 
you want to move, then press the Ctrl-key on your keyboard and keep this key pressed. Now you can 
move the selected channel(s) with the arrow keys on your keyboard. If you press the key "Home" or 
"End" while the Ctrl key is pressed you move the selected channel(s) to the beginning or the end of 



the list. 
 
With both methods described above you can move of course more than one channel. 
 
Another possibility is to move a channel directly to a position (e.g. channel 20 to position 5). Please 
select the channel, then click with the right mouse button in the channel list and select from the 
channel menu you get the function "Move to", the following dialogue appears: 
 

 
 
Here you can enter the channel number you like to move the selected channel to (in this example 5). 
The selected channel will be moved now in front of the channel that was previously at this position. 
If for example KABEL1 had a channel number higher than 5 before, it will be moved to channel 5. If 
the channel had a lower channel number before (e.g. 3) the channel will be moved in front of the 
channel that was at position 5. Because one channel is now missing in the list (the channel you are 
moving) all channels are moved up one position (i.e. to lower numbers), so in this case your channel 
will be moved to position 4. 
 
Especially if you use the drag & drop method it is often a problem that not all channels can be seen on 
the screen, so you have to scroll. If you want to move a channel from position 500 to 10 you have to 
keep the mouse button pressed while you move to position 10. If you move the mouse some pixels up 
and down at the border of the list, then the list will scroll in this direction. 
 
There are some functions that make moving channels more comfortable. For example you can hide 
one of the lists (TV or radio) to have more space for the channels. You can even hide the labels, 
transponders, the favourite list and the data window. Please call the channel menu and select on 
"Show" what you want to see (TV, Radio, TV and Radio, both channel types in a mixed list, "Show 
only channels" or "All lists"). 
 

 
 
If you double click on the name of a channel list the other list will be hidden. 
 

 
 
With a second double click on the name you will see both lists again. 
When you click on the letter "C" in the border of the channel lists, the labels, transponders, the 
favourite list and the data window are hidden. When you click on the letter "A", you will see all lists 
again. 
 
Another function that makes moving by drag & drop easier is the "split" function. Please click with the 
right mouse button in the channel list to open the channel menu and select the function "Split" from the 
popup menu. 
 



 
 
All channel lists (depending on what is shown/hidden) are now shown twice. It is of course the same 
list, but you have two different views of it. Changes in one of these lists will affect the other list too. 
You can move channels from the upper list to the lower list, because it is the same list but from 
different points of view, the entry is changed in both windows. 
 
If you make many changes to the channels, please remember to save from time to time. To do this hit 
the "file" button. From the file menu please select the item "save" to save the file. If you want to keep 
your original file and save the file with a different file name, you should use the "save as" function in 
the file menu. Enter the file name and click on the "save" button. 
 
With the function "Sort" in the channel list menu, you have several possibilities to sort the channels. 
 

 
 
Contrary to the function "View sorted by" the channels are not only shown in a different order, they 
also get another channel number. 
 
If you want to sort channels alphabetically, by frequency or polarity, you first have to mark the 
channels you want to sort. 
 
 
Continue with Labels. 
 



  
3.c Labels 
  
 
With the help of the label functions you can create new labels. This is interesting, because the 
DVB2000 uses the "labels" for the navigation in the channel list. Labels are channels with the 
frequency 0 on which you can jump directly with your remote control (semicircular arrow buttons left 
and right). 
 
In SetEditDVB2000 you can jump from one label to the next too. Please hit the button "Alt" on your 
keyboard, keep it pressed and hit the arrow buttons left or right. 
 
With the label functions you can divide the channels in logical blocks that you can access easily. 
 
Some labels are used as satellite markers too (see below). 
 
To create a new label please click with the right mouse button in the label list, you get the following 
menu: 
 

 
 
Now you click on "New", you get the following message: 
 

 
 
Here you can enter a name for the new label; e.g. "sport". Then you can choose if you want this label 
to appear only in the TV list, in the radio list or in both lists. The new label is marked with red 
background colour, because it has no channels yet, it is empty. 
 
You can change the order of the labels in the label list in the same way as the order of the channels in 
the channel list. I.e. with Drag & Drop or if you keep the Ctrl button pressed, with the arrow buttons, 
"Home" or "End". 
 
Now you can move channels into the new label. To do this please click on a channel you want to move 
and drag it with the mouse on the name of the new label. 
 
As you often don't see all labels in the label list, it may happen that you have to scroll. Just keep 
moving the cursor a little bit at the end of the list to scroll it in this direction. 
 
Sometimes - especially if you want to move many channels into the same label this will be easier if 
you click on the "F" above the label list. 
 

 
 
Now the label list does not always jump on the label of a new selected channel. 
If you click on the "S", the list will jump to the label of a new selected channel again. 
 
Each channel can only be in one label. Sometimes you would like to have a channel in more than one 
label. To do this you can create channel duplicates (which will have different channel numbers). 
 
To create a channel duplicate please click on the channel you like to create a duplicate of, then open 
the channel menu and select "copy" from this menu. Now select the desired position of the duplicate in 



the channel list and select "paste" from the channel menu. The original channel and the pasted 
channel are now marked red to show you that this is a duplicate channel. If you don't want to open the 
channel menu every time you can also use shortcuts for these functions, Ctrl-C is for copy and Ctrl-V 
is for paste. 
 
There are two ways to find such a duplicate later: 
 
When you move the mouse over a channel that is marked in red, you get a hint showing the number of 
a channel that is a duplicate of this channel. 
To find such a channel, first click on the channel list, then you can enter the channel number from the 
keyboard, so if you hit the key "1" channel 1 will be selected, "1" + "4" will select channel 14 etc. As 
with finding the channels by name, you have to enter the numbers within 3 seconds, otherwise the last 
entered number is taken as the first digit. 
 
You also have the possibility of using the "Find duplicates" function. Click with the right mouse button 
in the channel list and select "Find duplicates" from the popup menu you get. You will see the following 
window: 
 

 
 
All duplicates are shown. The different pairs of duplicates are marked in different colours. This function 
does not distinguish between different types of channels, i.e. it can happen that you see a pair of TV 
channel duplicates first and then a pair of radio channel duplicates. Relevant for this search are the 
transponder data and the channel ID, but not the name. If you activate the option "PIDs", the video, 
audio and PCR PIDs are compared too. 
 
For the "Find duplicates" window there are the same functions as for the "Find channels" window, i.e. 
you can delete and move channels from this window into another list and select if the duplicates are 
searched on all labels or only on the selected label. 
 
The DVB2000 does not know satellites. But as you can of course receive more than one satellite with 
your DVB2000, it is useful to mark these satellites. Some of the labels are used for this too. A label 
that is used as such a satellite marker, includes in its name the geographic position of the satellite 
(e.g. a label named Astra 19.2°E would be such a satellite marker). These pseudo satellites are 
marked with bold letters in the label list. 
 
In SetEditDVB2000 the pseudo satellites have the following relevance: 
If you convert DVB2000 settings into another format, the satellites you need for the other format are 
created from these pseudo satellites. (see chapter 3.k) 
 
The LNB functions use the pseudo satellites as well. In the DVB2000 the parameters for the antenna 
(DiSEqC and 0/12 V) are saved for each channel separately. Often all channels of a label belong to 
the same satellite (e.g. Astra or Hotbird). With the function "Change LNB" from the popup menu of the 
label list you have the possibility to change the antenna parameters for all channels of one label. 
 



 
 
If there are channels with different DiSEqC or 0/12 V parameters in the selected label (for example in 
a music label, in which you have music channels of Hotbird and Astra), "-" is marked for this label. 
 
If you change the LNB settings of a label that is used as a pseudo satellite in this way, you change the 
antenna parameters for all channels that are in a label between this pseudo satellite and the next 
pseudo satellite. 
 
These LNB settings are used for the import too (see chapter 3.j). 
 
In the DVB2000 you can use the labels for the motor control as well. The DVB2000 can control a 
motorised dish via an Echostar LT8700 that is connected to the serial port of the receiver. 
 
With Menu -> 9 -> A you can enter which LNB is active for this control and if the Echostar controls 
beside the motor control the polariser control and the band switch too. 
 
If the motor control is active and you switch on a label, the DVB2000 sends the corresponding 
command to the Echostar 8700. 
 
The satellite number is saved in the video PID of the label and the Vsec parameter of the 
corresponding Echostar satellite is saved in the Audio PID. 
 
With the functions "Change LT Sat" and "Change LT Vsec" from the popup menu of the label list you 
can enter these parameters. 
 



  
3.d The favourite list 
  
 
In the DVB2000 you have one favourite list that can hold 127 channels (until DVB2000 version 1.84) 
or 255 channels (DVB2000 version 2.00 or higher). 
 
To assign one or more channels to the favourite list simply move the selected channels by drag & drop 
on the name of the favourite list. 
 

 
 
To remove one or more channels from the favourite list you first have to select the FAV list you want to 
remove channels from. Then select the channels you like to remove and select "Delete" from the 
channel menu or hit the "Del" key on your keyboard. 
When you delete channels from the favourite list, the channels are only removed from the favourite 
list, but not from the main list. 
 
You can also use the "Mark as" function of the channel list menu to assign one or more channels to 
the FAV list or remove it/them from the FAV list. 
 
Channels that are in the favourite list are marked in the channel list with a darker background colour. 
To change this colour please see chapter 5.b. 
 
Within the FAV list you can change the order independent of the order in the main list. If you change 
the channel order within the FAV list by using the drag & drop function you will only change the order 
within the FAV list but not the order of the main list. In opposite the order within the FAV list is 
unchanged when you change the order within the main list. 
 
It is also possible to move labels to the FAV list to have markers within the FAV list. You can jump to 
these markers directly with your remote control. 
 
Note: You need at least DVB2000 version 2.00 to have the possibility to jump to these markers with 
the remote control. 
 
If you don't find the channels you expect in the favourite list after writing your settings into the receiver, 
you have probably entered the wrong DVB2000 software version in the configuration of 
SetEditDVB2000 (see chapter 5.b). 
 



  
3.e Channel parameters 
  
 
To rename a channel (e.g. "Das Erste" to "ARD") please select the channel and choose from the 
channel menu the function "change data" (or double-click on the channel), then you get the channel 
data menu: 
 

 
 
In the field "Name" you can now enter the name of the channel. 
 
If you find "<" and ">" in the channel name, these signs mark the short channel name. The DVB norm 
distinguishes between a short and a long name. 
The broadcasting stations have the possibility to transmit a long and a short version of the channel 
name. The DVB2000 uses the short version for the receiver display, where only a small number of 
letters can be shown and the long version for the channel list. 
 
These two signs don't appear in the channel list. In the long version of the channel name you see the 
entire name (except the "<" and ">" signs), in the short version you see only the letters between "<" 
and ">". For example the name <H>ome <O>rder <T>elevision would be "Home Order Television" as 
long name and "HOT" as short name. 
In the configuration of SetEdit you can change between these two viewing modes of the channels. 
In the case of the DVB2000 it may happen, that nevertheless there is a "<" character in a channel 
name. The receiver cuts the channel names behind the 24th character. So if the "<" is before and the 
">" behind the 24th character, the brackets are not complete and so you will see the opening bracket 
in the channel name. 
 
In the field "font" you can select the font that is used for the channel (e.g. Greek fonts for Greek 
channels). 
 
Furthermore you can change the transponder data (frequency, polarity, symbol rate and FEC) the 
PIDs and the Channel ID of the channel (see chapter 3.i). 
 
With "PIDs" you can choose whether the PIDs are shown decimal or hexadecimal. 
 
You can also mark channels as "scrambled" or "locked" within this menu or remove these markings. 
If you lock a channel this means you have to enter the parental pin to watch this channel. These 
channels will be marked in the channel list with a key symbol. Scrambled channels are marked with 
the following symbol: 

 
 
Note: If you remove the scrambled symbol this does not mean that the channel can be watched for 
free. This is just the marking of the channel. 
 
In the field "Service Type" you can change the type of the channel (TV, radio or data). 
 
Note: Channels that have the service type "TV channel" only appear in the TV list, "Radio channels" 
only in the radio list, channels with all other service types appear in both lists. 
 
In the field "Audio mode" you can select, if you hear the sound of both audio channels or only one 
channel (left or right) or if the audio channels are swapped. 



 
With the function "mark as" from the channel list menu you can change the following properties for 
more than one selected channel at once. You can: 
-Mark channel(s) as "(un)locked" or "(un)scrambled" 
-Assign channel(s) to the FAV list or remove it/them from the FAV list 
-Change several other reception parameters 
 
Furthermore you can use this function to link channels. To do this you have to select at least two 
channels because you can't link a channel with itself. Between linked channels you can easily zap. 
 

 
 
Many channels are only shown in uppercase letters. To change this, you don't have to enter a new 
name for each channel. Simply select the channels whose name you want to change and select the 
function "DISNEY CHANNEL -> Disney Channel" from the channel menu. 
 
The first letter of the individual words is never changed by this function. If mixed upper/lower case 
letters occur in the word, nothing is changed (example: EinsMuXx). Words with less than 4 letters are 
also not altered, so that abbreviations such as CNN stay unchanged. 
In the file SetEdit.ini there are lists of exceptions (which can be changed) to these rules. There is a list 
of 10 words that are not converted although they contain more than 3 letters, (example: ESPN, CNBC) 
and a list of 10 words that are converted although they are shorter than 4 letters (example: "CO" so 
that from KRIMI&CO you get Krimi&Co). 
 
The reasons why you might be interested in changing the channel names to lower case are that 
mixed-case writing is easier to read and lowercase letters are often narrower than uppercase letters, 
so that when you have more lower case letters in the channel name more letters can be shown in the 
channel list of the receiver. Channel names that do not fit within the channel list are truncated. 
 



  
3.f Data channels 
  
 
Usually data channels are no regular TV or radio channels. These channels are used for example for 
software updates for receivers or services like Internet by satellite. 
 
It may happen that the receiver finds some regular TV or radio channels not as a TV/radio channel 
when you make an automatic channel search and the receiver stores the channels as data channels. 
If you want to change this service type (the receiver does not take care about the service type as long 
as the other channel parameters are correct) please make a double click on the channel (or select 
"Change data" from the channel menu) and you can change the service type of this channel. 
 
You can use this function to assign a channel to both, the TV and the radio list. In the DVB2000 you 
see in the TV list all channels that are no radio channel and in the radio list all channels that are no TV 
channel. 
Data channels appear in both channel lists and are marked with white or grey (if the channel is in the 
FAV list) background colour. 
 
  
3.g Write settings into the receiver 
  
 
When you have finished making your personal settings you have to write them into the receiver before 
you can use them. To do this, please click on the button "File" and select the function "write into 
receiver" from the file menu. 
You get the following message: 
 

 
 
Now click on "OK" in this message and the settings data is transferred into the receiver. The receiver 
should be in normal operating mode. 
 
Note: If you want to write the settings into the receiver via the RS232 interface, you have to note: In 
many DVB2000 versions there is a bug. You can only write 2048 channels into the receiver via the 
RS232 interface. If you want to write more channels (up to 3072) into your receiver you have to use 
the SCSI port. 
 
If you don't find the channels you expect in the favourite list after writing your settings into the receiver, 
you have probably entered the wrong DVB2000 software version in the configuration of 
SetEditDVB2000 (see chapter 5.b). 
 
  
3.h Print or export settings 
  
 
You can print your settings. To do this click on the "File" button and select from the file menu the 
function "Print". You get the following dialogue: 
 



 
 
First you have to select if your printout should be sorted by channel numbers or by transponders 
(frequencies). 
 
If you print your channels in number sequence, you can also select whether you want to print all 
channels or only the selected ones. 
 
There are some options. You can choose if you also want to print the frequency, the label, the PIDs, if 
the channel is scrambled or if the channel is in the FAV list, etc. 
 
Finally you can enter the Font height for your printout. Then please hit the button "Print". A printing 
dialogue will appear, whose layout depends on the printer you have installed. 
 
With the "export" function you can export your settings to a plain ASCII file that can be opened with 
Word or Excel or other applications. The tab character (0x09) separates the different parameters. 
 
Besides this the export works the same as printing. Select "Export" in the file menu, then you select 
the optional parameters as described above and click on the button "Export". 
 
You get a window where you can enter the filename and select the directory of the exported file. 
 



  
3.i Using the transponder functions and entering new channels by hand 
  
 
There is a short summary of the transponder functions in chapter 5.e. 
 
In the DVB2000 there is no transponder list in the settings. The transponder data like frequency, 
symbol rate etc. are saved for each channel separately. If you want to compare your settings with 
Internet lists, it is easier if the channels are sorted by transponders. So a transponder list is created for 
SetEditDVB2000: the program compares the transponder data of all channels and all channels that 
have the same transponder data are assigned to the same transponder. 
 
If the transponder data were compared exactly, you would have many transponders that you could 
easily consider as the same because a difference in the frequency of only some MHz doesn't matter. 
For this reason you can enter a frequency tolerance in the configuration window. The number you 
enter there is the maximum difference between the original transponder frequency and the frequency 
of the channel that is being imported and is to be put to the same transponder. This tolerance is also 
used for the symbol rate. 5 MHz is a good value. 
 
Possibly when you read the settings from your receiver you wondered about channels with strange 
names and that some channels were missing in your list (e.g. German Premiere, soccer, Formula 1 or 
pay-per-view channels). 
 
Channels that share place (like the German ARTE/Kinderkanal) can only be found in the receiver if 
they are active at the time you make the channel search. Some of the Premiere Direkt, soccer and 
Formula 1 channels are found, but not with the right name. 
 
In the Internet there are sites (e.g. www.lyngsat.com) where you can find all channel settings 
(including the missing pay-per-view or soccer channels). In the following you find an explanation how 
to enter channels and transponders from such lists by hand. 
 
Suppose you discover on www.lyngsat.com that on satellite X a new transponder is active, but your 
receiver can't find this transponder at the moment, for example because it does not send at the 
moment (feed) or your antenna is not aligned to this satellite. 
 

 
 
Here we see that transponder 12656 horizontal is new and one scrambled TV channel (Anem, the 
orange background shows you that the channel is scrambled) and two audio channels (B2-92 with two 
different audio PIDs) are active on this transponder. 
 
You have to enter the TV channel and both audio channels one by one. 
 
First you have to click on the position in the channel list where you want to have the new channel, then 
you choose the function "New" from the popup menu of the channel list. You get the same window as 
for the "Change data" function, except that no parameters are entered yet. 
 
In the field "Name" you can enter the name of the channel (here "Anem") and in the section "Font" you 
can select the font that is used for the channel (e.g. Greek fonts for Greek channels). 
 
Then you have to enter the PIDs and the channel ID. 
 
The TV channel "Anem" for example (see list above) has the video PID 4194 and the audio PID 4195. 
The channel ID (service ID) is 1 and the PCR PID is as a rule identical to the video PID, so don't forget 
to enter it! 
 
For the Audio (radio) channels of course no Video PID is given. Usually you use the VPID 1FFF 
(hexadecimal) or 8191 (decimal) to indicate that this PID is not used. 
 
There are four additional PIDs that you usually won't find in the Internet lists. 



 
The text PID is used for the teletext information. 
 
The PMT PID (Program Map Table) identifies and indicates the locations of the streams that make up 
each service, and the location of the Program Clock Reference fields for a service. 
 
The AC3 PID is used for channels that have an additional audio track for Dolby Digital broadcasts. 
 
The PMC PID contains information about the scrambling system and the position of the EMM stream 
(if available). This PID is only used for scrambled channels. 
 
If you don't find these PIDs, you can enter 1FFF (hexadecimal) or 8191 (decimal) instead, i.e. "not 
used". For "normal" channels you don't need these PIDs and in the other cases you can let the 
receiver search for these PIDs (see below). 
 
Now you have to enter the transponder data for this channel. For the example mentioned above you 
enter 12656 for the frequency and HOR for the polarity. The symbol rate in this case is 2963 and the 
FEC is 3/4. 
 
The green numbers in the Lyngsat chart are the NETwork ID and the TS ID (here NET ID = 0 and TS 
ID = 176). 
These two IDs usually identify a transponder. The Network ID identifies the provider, the TS ID can be 
chosen by the provider himself. If a provider has more than one transponder on one satellite, the Net 
ID usually is the same for all these transponders, only the TS ID differs. 
 
The bandwidth depends on the symbol rate. Usually if the symbol rate is higher than 20000, the 
bandwidth is 30, for symbol rates lower than 10000, 6 MHz is usually used. Symbol rates between 
these two values are not common, but in this case the bandwidth is 15 MHz. 
 
In the field "DiSEqC" you enter the DiSEqC parameter for the satellite. 
 
Spec. Inv. should usually be set to "Auto". If a channel cannot be received like this (exotics), you have 
to try! 
 
With "12 V" you can control a 0-12 V switch for the selection of the antenna. 
 
With "PIDs" you can choose whether the PIDs are shown decimal or hexadecimal. 
 
In the field "Service Type" you can enter the channel type. The most imported types are "TV service" 
and "Radio service", so the channels can be shown in the correct channel list. Channels with all other 
service types are shown in both, the TV and radio list. You can use this for example for labels you 
want to have in both lists. 
 
If a channel is PAL coded, you should set "Video Enc" and "Video DEC" to PAL, for NTSC channels 
you should set these two parameters to NTSC. 
 
With "Audio mode" you can select if both audio channels are played, or only one (left or right channel) 
or if the two audio channels are swapped. 
 
If "Auto PID" is activated, the receiver tries to get the relevant PIDs (all except the PMT PID) from the 
Channel ID when you switch to this channel (if you enter other PIDs they are ignored). Zapping will be 
a little slower if you use this function, but you don't have to take care about changes in the PIDs. 
 
If you activate "Auto PMT" the receiver tries to detect the PMT PID automatically. 
 
When you have entered all the parameters please click on OK and the new channel will appear at the 
selected position. 
 
With the button "Test" the receiver will be switched to exactly this transponder (frequency, polarity, 
symbol rate, FEC, DiSEqC and 12 V) and the PIDs (video, audio, text and PMC PID). So you can test 
and check the channel parameters. 
 



There is also the possibility to let the receiver search for the correct PID values. To do this please click 
with the right mouse button in the transponder list and select the function "Scan transponder" from the 
popup menu you get. You will see the following window: 
 

 
 
If you have selected a transponder before, the values of this transponder are taken. Otherwise, please 
enter the transponder data to the intended fields. You need the frequency, symbol rate, polarity, FEC, 
12 V and DiSEqC values. 
When you click on the button "Start" the receiver will search for channels on this transponder. 
 
This function is equivalent to the receiver function Menu -> 6 (Tuner) -> Enter the transponder data (1-
4) -> 9 (search) if the receiver is connected to the PC with a RS232 cable. If you use the SCSI 
connection, the tuner is set to the transponder data and SetEditDVB2000 reads the PIDs directly and 
shows you the result. Sometimes this can take more time as the way with the RS232 port. 
 
Note for experts: First the PAT (Program Association Table) and the SDT (Service Description Table) 
is read, then for all entries that are found (channels) the PMT (Program Map Table) where all PIDs are 
listed is read and the result is shown in the list. 
 
You can move channels from this window by drag & drop to your channel list. (If you have opened 
more than one SetEdit Window you can copy these channels of course to any open window). 
 
Channels that are marked with green colour are not present in your channel list, they are new. 
 
If there are channels in your channel list that are marked with red colour, this means that these 
channels are not found on the transponder at the moment. Maybe the channel data are not correct or 
the channel is not active at the moment you make the transponder scan. 
 
When you activate PMC PID and/or Text PID these PIDs are also compared to find out if a channel is 
already present in your list. For free to air channels (FTA) the PMC PID is irrelevant. 
 
If you want to enter channels that differ only in few parameters, it is useful to create a duplicate of a 
channel (please use the copy and paste function from the channel menu) and then change only the 
different parameters. 
 
For German Premiere it is often useful to have channel duplicates. For the sports channels you will 
find different events (e.g. Champions league, Formula 1, etc.) on the main channels and "special 
channels". Sport 1 is for example identical to a Formula 1 perspective and a Superdom (soccer) 
channel. If you like to switch during a Formula 1 transmission between the different feeds it is useful to 
have all these feeds in one block to prevent from skipping several channels. The same rules aim for 
champions league and other events. 
 
Note: In some lists the PIDs are given in decimal notation, in others in hexadecimal notation (see 
chapter 8). You have to be aware of that when you enter the PIDs. In the configuration menu and in 
the channel data window you can specify if you want to see/enter the PIDs in decimal or hexadecimal 
form. 
 



 
 
When you enable the option "always on top" in the configuration menu, SetEditDVB2000 will always 
be in the foreground on your desktop. This can be useful when you work with such Internet lists, as the 
SetEdit window will not go into the background when you click in the browser. 
 
You also change the notation of the PIDs if you click on the "H" for hexadecimal or "D" for decimal in 
the border of the "Info" section. 
 
To compare your settings file with lists in the Internet that are often sorted by frequencies you have the 
possibility to sort the transponders of your settings file by frequency. To do this click with the right 
mouse button in the transponder list and select "view sorted by" -> "frequency" from the menu you get. 
Alternatively you can also view the transponder list sorted by polarity. 
You can also set the viewing mode by clicking on the letters "O" (original), "F" (sort by frequency) and 
"P" (sort by polarity) in the frame of the transponder list. 
 



  
3.j Import of channels 
  
 
You have the possibility to get ready-made settings lists from the Internet. These lists can be used 
partially or completely. You can find such lists for example at the following URLs: 
 
The most current settings lists for the DVB2000 (Nokia 9500/960x) are on www.dxandy.de. It is 
possible to import channels from these settings into your settings list (especially exotic channels are 
up-to-date in this list). 
 
On www.lyngsat.com/nokia/index.shtml or on the SatcoDX site (you can find a link on my homepage) 
you will also find listings of all satellites. 
 
There are three possibilities to use such settings files. In this chapter you find a description how to add 
some channels from an other settings file into your settings file. 
 
 
The import function 
 
You can import channels from all settings formats that are supported by SetEdit into your 
SetEditDVB2000 settings. In the standard version you can import channels from SetEditDVB2000 
settings, Lyngsat DAT charts and SatcoDX SDX files. 
 
You can add other formats by copying the corresponding modules (SetEditXXX.dll) into the SetEdit 
directory (see chapter 2.) 
 
Please click on "File" -> "New" and select the format of the settings file, from which you want to import 
channels. 
 

 
 
A second window with the chosen settings file will be opened. In the same way you can open a third or 
even more settings files. Each of these lists is equivalent. Every format (DVB2000, SatcoDX, Lyngsat 
or other added formats) has its own symbol. 
SatcoDX and Lyngsat files are only Internet lists, so the functions "Read from receiver" and "Write into 
receiver" do not exist for these formats. 
 
Now you can easily transfer one or more channels by drag & drop from one window into another or 
"Copy" and "Paste" them with the corresponding functions from the channel lists menu. 
 
Note: As the DVB2000 only supports digital channels you can't import analogue channels. It may 
happen, that there are analogue channels for example in a SatcoDX file. 
In the configuration of the SatcoDX settings file you can choose, if you only want to see analogue or 
digital channels or both. 
 
In the different settings formats there are different channel parameters. If a parameter only exists in 
the destination list but not in the source list (e.g. there are no Text PIDs in the SatcoDX files), a 
standard value will be taken for this parameter. 
 
You can also drag and drop groups of channels (for example entire transponder with all its channels) 
from one window into another. 
 
Source: 
 
Channel list: The selected channels will be transferred. 
 
All other lists (satellites, providers, labels, transponders, etc): All channels of the selected list will be 
transferred. 
 
Find window (e.g. "Find channels", "Find duplicates", "Scan transponder"): the selected channel will be 



transferred. 
 
Destination: 
 
Channel list: The imported channels will be pasted at the location the cursor is on at the moment you 
paste the channels. Sometimes it is only possible to paste a channel, if a definitely assignment (e.g. to 
a satellite) is possible in the destination list. For the DVB2000 you can always paste a channel 
because all necessary information is saved in each channel. 
 
Transponder: The DVB2000 does not really know transponders (all transponder information is saved 
for each channel separately) In SetEditDVB2000 a transponder list is created from the transponder 
data of the channels. For SetEditDVB2000 a transponder is unique assigned to a label. When you 
assign channels from another list to a transponder these channels are automatically assigned to the 
label of this transponder. The channels are inserted at the end of this label. 
If you drag and drop a transponder from one window into the transponder list of another window, this 
transponder with all its channels will be added as a new pseudo transponder. 
 
Note: If you import a transponder from another window, this transponder will be added to the label that 
is selected. 
 
If you drag and drop a label with all its channels to the transponder list of another window, all these 
channels will be added to the transponder the cursor is on. This will also happen to channels that 
come from another FAV list, provider, satellite, etc. 
 
Note: It may happen that you can't receive a channel, if you assign it to the wrong transponder. 
 
Label: The imported channels will be added to the label the cursor is on. Transponders that don't exist 
yet in the transponder list of the destination settings file, will be created. 
 
Favourite list: A direct import into the favourite lists is not possible. 
 
General note: If there is a possible assignment, you can copy channels from each list of one window to 
each list of another window. For example you can transfer channels from the "Find channels" function 
of a SatcoDX list to a label of a DVB2000 list. 
 
In the popup menu of the channel list there are two functions that may help you to compare the 
channel lists of different settings files. These functions are only available in the channel list menu, if 
two or more SetEdit windows are opened. 
 
With the function "Mark new channels in" you can mark in another window the channels that do not 
exist in your actual list. (The channel number of these channels will be marked in green.) 
 

 
 
If more than two lists are opened, you have to select in which list you want to mark the new channels. 
If only two windows are opened, only one possibility is given. 
 
With the function "Mark not existing channels in" you can mark in your actual list those channels (the 
channel number will be marked in red) that do not exist in another window. 
 
If more than two lists are opened, you have to select the channel list that you want to compare your 
actual list with. If only two windows are opened, only one possibility is given. 
 
With "Remove not existing channel markings" or "Remove new channel markings" you can remove the 
corresponding markings. These functions will only appear in a channel list menu, if there are such 
markings in the channel list. 
 
If you have marked the "new channels" or the "not existing channels" in a channel list, you can select 
them all. 
Please click in the channel lists menu on select and choose the corresponding entry: "all not existing" 
or "all new". This entry will only be shown in the menu, if there are such markings in the channel list. 
 



Note: For the import of channels it is useful, to choose in the configuration the value 5 or even 10 MHz 
for the frequency tolerance. It may happen that the frequency of the same channel differs just a little 
bit in different lists. If the frequency tolerance is 0, these channels will be marked as "new" or "not 
existing" too. But a difference of only some MHz is insignificant to the receiver, so you don't need to 
import these channels. 
 



  
3.k Other settings and how to convert a settings file 
  
 
In the following you find a description how to use a settings file found for example in the Internet 
completely and how to convert a settings file into the format you need. 
 
 
Other SetEditDVB2000 settings files 
 
You can load SetEditDVB2000 settings directly into the SetEditDVB2000 main list (with File -> Open) 
and then write them into the receiver. 
If you like to take settings you find in the Internet completely you may get problems because in 
addition to the pure channel data also the satellite and LNB configuration are included in the settings 
file you got from the Internet. It may be possible that you don't want this configuration or that this 
configuration does not fit to your receiver (LNB configuration). You have the possibility to save your 
own configuration separately and load it after opening the Internet file into this file. 
 
To use these functions it is necessary that that your own settings and the settings you want to load 
achieve the conditions you find in chapter 3.c (i.e. a label is a pseudo satellite when the geographic 
position is part of the name). 
 
To have the possibility to correct these settings automatically, you first have to save your own 
configuration. 
 
Please click on the button "File" and select the function "Save satellite configuration". Now SetEdit will 
check if all channels of all pseudo satellites have the same DiSEqC and 0/12 V settings. If all channels 
have the same settings these settings are assigned to the geographic position of this pseudo satellite. 
If these settings are not the same for all channels, you will get a warning message. The allocation 
geographic position < -> LNB settings is saved in a satellite file (SetEditDVB2000.sat). Additionally the 
LT8700 motor control data (Vsec and satellite number) is saved in this file. 
 
When you load a settings file from other sources you can choose the function "Load satellite 
configuration" from the file menu to overwrite all these parameters from the values saved before. 
SetEditDVB2000 searches for each geographic position of a pseudo satellite of the settings file you 
like to load the LNB settings in the file SetEditDVB2000.sat. If SetEditDVB2000 finds a suitable entry 
all channels of this pseudo satellite are set to these LNB values. If no entry is found for a position you 
will get a warning message and the LNB settings are unchanged. 
 
If you often take settings from the Internet but always want to keep your satellite settings, you can 
enable the option "When loading use personal sat settings" in the configuration menu. Then this part 
of the settings is always taken from your previously saved configuration. 
 
In the DVB2000 the general settings of the receiver are not saved with the other settings. But you can 
save them in a seperated file. 
In the file menu you can find the function "General settings". With this function you can read the 
general settings from your receiver, change them, save them and write them back into your receiver. 
 

 
 
 
Convert a settings file 



 
You can convert all settings formats that are supported by SetEdit and for that you have got the 
corresponding module (in form of a DLL file) into the SetEditDVB2000 format. 
 
In chapter 2 is described how you can add other SetEdit modules. 
 
Please open with "File" -> "New" an additional editor window with the format of the file you wish to 
convert. 
Then please load with "File" -> "Open" the settings file you want to convert into another format. 
 
You can convert all settings formats that are supported by SetEdit and for that you have got the 
corresponding module (in form of a DLL file) into the SetEditDVB2000 format (except formats that only 
contain analogue channels). If you want to convert your SetEditDVB2000 settings into another format, 
it depends on this format, if you have to save the satellite configuration for this format first or if this isn't 
necessary (e.g. DVB2000, SatcoDX or Lyngsat). 
 
Important for converting into other SetEdit formats: If you convert a settings file only the pure 
channel and transponder data is taken from the source settings file. The satellite and LNB 
configuration are taken from the satellite configuration that has to be saved before (see above). 
If some channel parameters don't exist in the source settings file, a default value is taken for 
this parameter. 
 
Now you can convert the loaded settings file. To do this, please click on "File" -> "Convert to" and 
select the format you want to convert this settings file to. 
 

 
 
Now you see the loaded settings file in the new format with the corresponding SetEdit version on your 
screen. 
 
Note: The different settings formats often contain different information, so you will always loose 
information, when you convert a settings file. If you convert e.g. a SetEditDVB2000 settings file into 
the SatcoDX format and back, you will see that all labels that are no pseudo satellites (see chapter 
3.c) have disappeared because the SatcoDX settings don't have labels. If you convert a SatcoDX 
settings file into the SetEditDVB2000 format and back, you will recognize, that all analogue channels 
have disappeared. The DVB2000 receivers only support digital channels. In the same way it may 
happen that certain PIDs (e.g. the text PID), volume information or the flags for "Scrambled" or 
"Locked" get lost. 
 
In the configuration in the menu "Convert" you can enter the options that should be used, if you 
convert into this format (see chapter 5.b). 
If you want to convert another settings file into the SetEditDVB2000 format, you can for example sort 
the channels by satellites or take the FAV lists from the source list. As the DVB2000 only has one FAV 
list, all channels that were in any FAV list before, will be assigned to this favourite list. 
If you want to convert a SetEditDVB2000 settings file into another format, you have to choose these 
options in the configuration menu of this other format. 
 



  
4 Program use and personal configuration 
  
 
SetEditDVB2000 is mostly used with the mouse. You can also reach many functions with keyboard 
shortcuts. 
 

 
 
On the main window you will find a group of buttons for the general functions ("File", "Config." and 
"Help") and the lists that contain the transponders, labels, the favourite list (FAV) and the channels. If 
you hit the right mouse button in the label, transponder or one of the channel lists you will get a popup 
menu with the specific functions for this list. 
With "Help" you can open the help file or look for updates of SetEdit. 
In some frames you find uppercase letters. If you click on these letters you can change some viewing 
modes. 
 
You can close every window that comes in SetEditDVB2000 (except the main window) with the Esc-
key on your keyboard. 
 
In some lists you may find the following red symbols. These symbols indicate: 
 

  Scrambled channels 
  Locked channels 

 
If a channel name is marked red there is a duplicate of this channel in the settings. 
 
Labels marked in red are empty; they contain no channels. 
 
TV channels appear in light blue, radio channels in light green and data channels in white. 
 
Labels that are only in the TV or Radio list are also marked with these colours. 
 
Channels that are in the FAV list are marked in the channel list with a darker background colour. 
 
If the channel number is marked with a red background colour, the channel is assigned to a vertical 
polarised transponder. If the channel number has a white background colour, the channel is assigned 
to a horizontal polarised transponder. 
 
When you select a channel, the transponder, the label and the favourite list (if the channel is in the 
favourite list) are marked with a different colour. 
 
You can change all colours in the configuration menu. 
 
In the lower left corner you will find an "Information" section, where you see the parameters of a 
selected transponder or channel. 
 



 
 
When you select a label in the label list only the transponders and channels that are in that label are 
shown. When you click in a transponder or favourite list only the channels that are in this list are 
shown. 
 
 
You can adapt the design of SetEditDVB2000 to your personal wishes. 
 
To change the size of the main window you can either click on the maximise button in the upper right 
corner or drag one of the margins of the window. 
 
If the main window is large enough, the channel lists can be shown in more than one column. Then 
you have more channels in view. You can change the width of these columns in the configuration 
menu on the tab sheet "General settings". In the section "Column width" you can enter if a new column 
is created, when 100% (auto) or 90-30% of the channels are shown completely. The other channel 
names are cut. 
 

 
 
With "manual" you can enter the column width by hand. Select the function "Setup column width" from 
the menu of the channel lists and then you can click on the position where you want to have the right 
border of the first column. 
 
Note: There is a minimum width for the columns. If the window is too small to show more than one 
column the column width has no effect. 
 
In the section "Cut names" you can enter if the channel name is cut at the end,  
 

 
 
or if a part of the channel name is cut from the middle. 
 

 
 
In the configuration on the tab sheet "General settings" you can change the menu language of SetEdit 
(this concerns all opened SetEdit windows) and specify whether the PIDs are shown in decimal or 
hexadecimal form (see chapter 8). 
 
To get more columns in the window, you can enter that the channel names are shown in their short 
mode (see chapter 3.e). 
 
If you activate on the same tab sheet the option "Show channel count in lists" the number of channels 
of each label, transponder and the FAV list is shown behind the name of this list. 
 
Especially when you want to move channels from the beginning to the end of your list, it may be useful 
to use the split function. With this function you can split your list into two parts, one showing the 
beginning and the other showing the end of your settings (see chapter 3.b.) 
 
With a double-click on the frame "TV channels" or "Radio channels" only the choosen channel list is 
shown. With another double-click on this frame both lists are shown again. With the "show" function of 
the menu of the channel list you have also the possibility to choose, if you only want to see the TV, the 
radio channels, or both channel types or if you want to have all types of channels in one mixed list. 
 
You can also change the viewing mode of the PIDs, if you click on the letters "H" for hexadecimal or 



"D" for decimal in the frame of the "Information" section. 
 
For some functions you also have shortcuts for keyboard using: 
Ctrl-O: Open a settings file 
Ctrl-S: Save settings 
Ctrl-R: Read settings from the receiver 
Ctrl-W: Write settings into the receiver 
Ctrl-P: Print settings 
Ctrl-E: Export settings 
Alt-R: Show only radio channels 
Alt-T: Show only TV channels 
Alt-M: Show TV and radio channels in a mixed list 
Alt-A: Show TV and radio channels 
Ctrl-0 (zero): Load the last used file 
F1: Help 
F2: Satellite list 
F3: Label list 
F4: Transponder list 
F5: Provider list 
F6: FAV list 
F7: TV list 
F8: Radio list 
F10: Configuration 
F11: Toggle between "Show only channels" and " Show all information" 
 
Depending on the editor you are using, some lists are not available, for example the DVB2000 has no 
satellite list. 
 
To close a SetEdit window please click on the "close" button: 
 

 
 
or select "Close" from the "File" menu. If only one editor window is opened you close the complete 
program. 
 
If you select "Exit" from the "File" menu all open editor windows are closed. In the configuration you 
can enter with "Restore last session when starting" that all opened editor windows are restored when 
you start the program the next time. 
When you like to use this function you have to finish from SetEdit with the "File" -> "Exit" function. If 
you close all windows one by one only the last opened window will be restored. 
 
Note: If you have unsaved changes you are asked if you want to exit or first save these changes. 
 



5 Functions  
  
5.a File functions 
  
 
To get the file functions, please click on the "File" button. You will get the following popup menu: 
 

 
 
With New you can open another window of SetEdit with the same or another format, e.g. for the import 
of channels or if you want to compare different channel lists (see chapter 3.j.) 
 
With Open you can load settings from your disc. 
 
With Last files you get a list of the 10 last used files, which you can load. 
 
With Clear last files list you can remove all entries from the last files list. 
 
With Read from receiver you can read the settings from your receiver into SetEditDVB2000. You get 
a message on your screen. When you have clicked on "OK", the settings are read from the receiver 
and shown in SetEditDVB2000. The receiver should be in normal operating mode. 
 
With Backup you can transfer the settings from the receiver directly to your hard disc without having 
them in SetEdit. You will first get a window where you can enter the directory and the file name. 
Otherwise the procedure is similar to "Read from receiver". 
 
With Save or Save as you can save the current settings to your disc. 
 
With Write into receiver you can transfer the settings from SetEditDVB2000 to your receiver. You 
also get a message. When you have clicked on "OK", the settings are written into the receiver. 
 
With Restore you can transfer settings from your hard disc directly to your receiver. First you get a 
window where you can select the file you like to transfer into the receiver. Otherwise the procedure is 
similar to "Write into receiver". 
 
With Convert to you can convert your actual loaded settings file into another settings format (e.g. 
SatcoDX). If you want to convert another settings format (e.g. SatcoDX) into the SetEditDVB2000 
format you first have to open a new editor window (with File -> New) with the corresponding SetEdit 
format (e.g. SatcoDX) and then you can load the settings file you want to convert in this editor window. 
To do this it is useful (for some formats necessary) to save your satellite configuration first (see 
chapter 3.k). 
 
With Firmware update you can update your receiver firmware (it is necessary that you already have a 
DVB2000 firmware in your receiver). You get a file select box where you can select the firmware file 
that you want to write into your receiver. 
 
Note: When you work with the RS232 port it may happen that the receiver does not reboot after the 
update, in this case, please unplug the main plug and restart the receiver. 
 
With Print you can print your settings. 



 

 
 
You have two ways of printing your settings. You can either sort the list by the channel numbers (to 
have a printed channel list) or by the transponders of the channels (to compare your settings with lists 
in magazines). 
 
If you print your channels in number sequence, you can also select whether you want to print all 
channels or only the selected ones. 
 
The channel number and name are always printed; additionally you can print the transponder data 
(frequency, symbol rate, polarity and FEC), the label, the PIDs, the Channel ID and the flags for 
"scrambled" or "FAV". 
 
In the field "Font size" you can enter the size of the font that is used for printing. If more than one 
column will fit on the page you will get a multi column printout. 
 
With Export you can export your settings as an ASCII file (e.g. to open it with Word). You have the 
same options as with the print function. 
 
General settings: 
 

 
 
Here you can read the general receiver settings from your receiver (with File -> Read from receiver), 
save the general settings to disk (with File -> Save or Save as) change the data and write the data 
back to your receiver (with File -> Write to receiver). With File -> Open you can open previously 
saved general settings to change them or write them into your receiver. 
 
The general receiver settings contain for example the parental pin (see tab sheet "general"), the time 
zone ("Delay/Timer/Video") to switch between summertime and wintertime, the LNB settings (LNB 
configuration), the baud rate for the RS232 port (External) etc. 
 
Note: When you change the baud rate in the general settings you have to change the baud rate in the 
configuration of SetEditDVB2000 too, otherwise you can't access your receiver. 
 
With File -> Exit you leave this menu (alternative you can hit the ESC button of your keyboard). 
 
Note: It is useful to make a backup of your general receiver settings. If you misconfigure your receiver 
in such a way that you can't work with the remote control anymore (for example the menus are outside 
the viewable area) you can write the previously saved settings into your receiver and you can work 
again. 



 
Load satellite configuration: 
With this function you can overwrite the satellite configuration of the actual settings with a 
configuration you saved before. In the configuration menu you can enter that this is done automatically 
when you load a file. 
 
Save satellite configuration: 
With this function you save the satellite configuration of the actual loaded settings file (see chapter 3.j). 
 
With Close you close the actual active SetEdit window. If only one window is opened you close the 
complete program. 
 
With Exit you exit from SetEdit. All open editor windows are closed. In the configuration you can enter 
with Restore last session when starting that all opened editor windows are reopened when you start 
the program the next time. 
When you like to use this function you have to finish from SetEdit with the "File" -> "Exit" function. If 
you close all windows one by one only the last opened window will be restored. 
 



  
5.b Configuration 
  
 
Click on the "Config." button to change the general settings of SetEdit. There are three tab sheets in 
the configuration menu. 
 
 
General settings: 
 
If you click on "General settings" you get the following menu: 
 

 
 
In the field Comport you can select which comport of your PC is used to connect to your receiver (or 
select SCSI if you like to work with the SCSI port of the receiver). 
 
The value Frequ. Tol. (Frequency tolerance) is used when importing and indicates the tolerance a 
transponder frequency may have relative to the imported one to be considered to be the same. If you 
have for example a transponder with the frequency 11721 MHz in you settings and you import a 
channel with the frequency 11720 MHz and the frequency tolerance is set to 5 MHz no new 
transponder is created. This tolerance is also used for the transponder list. This tolerance is also used 
for the transponder list (note: the DVB2000 has no real transponders, so channels with frequencies 
within this tolerance are put together to one unique pseudo transponder). 
 
With Column width you can select if 100% (auto) or 90-30% of all channels have to fit completely to a 
column. All other channel names are truncated. With "manual" you can enter the column width by 
hand. Please select the function "Setup column width" from the menu of the channel lists and then you 
can click on the position where you want to have the right border of the first column. 
 
Note: There is a minimum width for the columns. If the window is too small to show more than one 
column the column width has no effect. 
 
With Baud rate you change the speed for serial communication (see chapter 3.a). 
 
In the Combo box Receiver you can enter the DVB2000 firmware version your receiver has. From 
version 2.00 254 favourite channels are possible and the favourites are saved at another location as in 
the versions until 1.84. If you enter the wrong receiver version the favourites in SetEditDVB2000 do 
not match with the favourite list in the receiver. 
 
In the field Cut names you can enter, if channel names that are too long (see column width), are cut at 
the end or in the middle. 
 
In the field PIDs you select how the PIDs are shown/entered (decimal or hexadecimal). You can also 
switch between these two viewing modes, if you click on the "H" for hexadecimal or the "D" for decimal 
in the frame of the "Information" section. 
 
With Language you can select the menu language you would like. This language is taken for all 
opened SetEdit windows. 
 
With Always on top SetEditDVB2000 always stays on top of your desktop. 
 



With Names: short you will get the short names of the channels in the channel list (see chapter 3.e). 
 
With Start with last used file SetEditDVB2000 opens automatically the last used file every time you 
start the program. 
 
With When loading use personal sat settings you can, after you have once saved your satellite 
configuration (see chapter 3.k), use this configuration automatically when loading settings. For 
example you can use your satellite settings always when you load settings from other sources. 
 
If Restore last session when starting is activated, all editor windows that were opened when you 
closed the last session are reopened (see chapter 5.a.) 
 
If you activate Show channel count in lists the number of channels of each satellite, transponder 
and the favourite list is shown behind the name of these lists. 
 
 
Colours: 
 
If you click on the tab sheet "Colours", you will get the following menu: 
 

 
 
Here you can change the colours that are used to mark the following states: 
 
Horizontal polarised transponders, vertical polarised transponders 
 

 
 
TV channels and radio channels 
 

 
 
TV or radio channels that are in the favourite list 
 

 
 
Transponder, label and FAV list of an actually selected channel (Active Tr/Lab/FAV) 
 

 
 
Channel duplicates 
 



 
 
Empty labels 
 

 
 
New or not existing channels (for the import function, see chapter 3.j) 
 

 
 
The icons for "locked" and "scrambled" 
 

 
 
With a double click on the frame of a colour field, you get the default colour again. 
 

 
 
 
Convert: 
 
On the tab sheet "Convert" you can choose which options should be used, if you convert another 
settings file into the SetEditDVB2000 format. 
 
Sort channel list by satellites: The channels of the source list will be sorted by satellites, when you 
convert into the DVB2000 format. 
 
Convert providers to labels: All providers of the source list will be converted to labels. 
 
Convert FAV lists to labels: All FAV lists of the source list will be converted to labels. Even if a channel 
is in more than one FAV list in the source list, it will appear only in one label. 
 
This option may be useful for example if the source list has more FAV lists as you can have in your 
SetEditDVB2000 settings and you want to keep all of them. 
 
Take FAV list(s) from source list: All FAV lists will be taken from the source list. As the DVB2000 
only has one FAV list, all channels that were in any FAV list before, will be assigned to this favourite 
list. 
 
If you want to convert a SetEditDVB2000 settings file into another format, you have to choose these 
options in the configuration menu of this other format. Depending on the receiver there can be up to 
10 different options. 
 



  
5.c Channel functions 
  
 
Please select the channels you like to edit/modify. 
 
You get most functions when you click with the right mouse button on a channel list. You will get the 
popup menu of the channel list: 
 

 
 
Some menu items are only visible, when you are using the import functions. 
 
Info: Here you get the number of TV, radio and data channels and labels that are in your settings. 
 
With Show you can change the viewing mode of SetEditDVB2000. You can select if you only want to 
see the TV or the radio channels, both lists or one list with all channels (mixed). 
 
Note: Alternatively you can double-click on the TV/Radio frame to change the viewing mode. 
 
Furthermore you can hide the labels, transponders, the favourite list and the data window with Show 
only channels. With All lists you can see all lists again. 
 
With View sorted by the channel list can be shown in the original order, sorted alphabetically or 
sorted by frequencies or polarities. 
 
With Change channel data you get the following window where you can change the properties of a 
channel: 
 

 
 
In the field Name you can change the name of the channel. If you find "<" and ">" in the channel 
name, this is to distinguish between the short and the long channel name, see chapter 3.e for details. 
 
You can enter the font that is used for a channel (for example for Greek or Russian channels). 
 
You can enter the PIDs, the Channel ID (Service ID), the Service Type (TV, radio or data channel) 
and the transponder data of the channel and enter, if the channel is locked (you have to enter the 



parental PIN) or scrambled. 
With PIDs you can choose if the PIDs are shown decimal or hexadecimal. 
 
You can find a longer description of the different PIDs, IDs and transponder data in chapter 3.i. 
 
With Delete you can delete selected channels or, when you are in the FAV list, remove them from this 
favourite list. 
You can also delete one or more selected channels by hitting the Del key on your keyboard. 
 
With Copy you can copy a channel, then you can paste the channel to another position. 
 
With Paste you can paste a channel that was previously deleted or copied. 
 
With Move to you can move a channel to a position that you enter with the keyboard. 
 
With Select you can select all, all scrambled, all locked, all data channels, all C-band channels or 
(for the import) all new or all not existing channels (depending on which channels are actually 
marked). 
 

 
 
With Invert selection you can invert the selection, the channels that are selected will become 
unselected and vice versa. If you like to delete all but one channel from a transponder, you can select 
the channel you like to keep, invert your selection and delete the now selected channels. 
 
With Mark as you can change the following properties for one or more selected channels at once: 
-Mark channel(s) as "(un)locked" or "(un)scrambled" 
-Assign channel(s) to the FAV list or remove it/them from the FAV list 
-Change several other reception parameters 
 
Furthermore you can use this function to link channels. To do this you have to select at least two 
channels because you can't link a channel with itself. Between linked channels you can easily zap. 
 

 
 
Mark new channels in: If you have opened more than one window of SetEdit (Import), you can mark 
in another channel list the channels that you don't have in your actual channel list. 
 
Mark not existing channels in: If you have opened more than one window of SetEdit (Import), you 
can mark in your actual channel list the channels that you don't have in another channel list. 
 
Remove new/not existing channel markings: With this function you can remove the markings for 
new or not existing channels in your actual list (Import). 
 
With Sort you can sort selected channels by alphabet, by frequency or by polarity. 
 
With DISNEY CHANNEL -> Disney Channel you can change the names of the selected channels 
from upper case to lower case. Uppercase letters are usually wider than lower case letters, so this 
allows you to see more characters of the name in the channel list of the receiver. Only words with 
more than 3 characters are converted. If there are both upper and lower case letters in the channel 



name the word is not converted (e.g. EuroSport stays as it is). In the configuration file of 
SetEditDVB2000 (SetEdit.ini) there is a list of up to 10 words that are converted although they are 
shorter than 4 letters (CO, INT, FOX) and a list of words that are not converted although they are 
longer than 3 letters (CNBC, ESPN). 
 
With Find channels you can find channels by name. 
 
With Find duplicates you can look for channel duplicates. 
 
Show linkage: In the DVB2000 it is possible to link channels together. Between linked channels you 
can easily zap. With the function "Mark as" (see above) you can create such linkages. 
 
With Test the receiver is switched exactly to the transponder data (frequency, polarity, symbol rate, 
FEC, DiSEqC and 12 V) and the video, audio, PCR, text and PMC PIDs of an actually selected 
channel. With this function you can verify PIDs and channel data. 
 
With Switch receiver you can switch the receiver on the actually marked channel number. I.e. if you 
switch the receiver on channel number 5, the receiver will switch on this channel number, regardless if 
there is the same channel on this number in the receiver as in the actually in SetEditDVB2000 loaded 
settings file. 
 
With New you can create a new channel. 
 
With the Split function you can tile the TV and radio list in two parts. It is the same list but from two 
points of view. Changes in one list also affect of course the second list. You can move a channel from 
the upper to the lower list of course. 
 
The function Setup column width is only visible in this menu, when you have entered "manual" in the 
section "Column width" in the configuration menu (see chapter 5.b). With this function you can enter 
the column width by hand. Please select this function and then you can click on the position where you 
want to have the right border of the first column. 
 
Note: There is a minimum width for the columns. If the window is too small to show more than one 
column the column width has no effect. 
 
To move channels you simply drag them with the mouse to the position where you want them to be (if 
you reach the border of a list the list will scroll automatically). 
 
To assign one or more channels to a label, transponder or the favourite list drag it/them with the 
mouse to the name of the label, transponder or favourite list. 
 
To see all channels of a label, transponder or the favourite list, please click in the respective list on the 
corresponding entry. 
 
In the frame of the channel list there are several uppercase letters for the following functions: 
 
A: The channels and the labels, transponders, FAV list and the data window are shown. 
C: Only the channels are shown. 
O: The channels are shown in original order. 
N: The channels are shown in alphabetical order. 
F: The channels are shown sorted by frequencies. 
P: The channels are shown sorted by polarities. 
 
 
Continue with Label functions. 
 



  
5.d Label functions 
  
 
In the DVB2000 you can navigate in the channel lists with the help of the labels (semicircular arrow 
buttons left and right). 
 
In fact a label is a normal channel with the frequency 0. 
 
A label can be in only one of the channel list or in both of them and it has the corresponding 
background colour: light blue if the label appears only in the TV list, light green for the radio list and 
white, if it appears in both lists. 
 
Labels that are marked in red are empty, i.e. contain no channels. 
 
In the channel list of SetEditDVB2000 you can jump from one label to the next too. To do this keep the 
Alt key of your keyboard pressed and hit the arrow buttons right or left to jump to the next or previous 
label in the channel list. 
 
With the label functions you can divide the channels in logical groups that you can easily reach with 
your remote control. 
 
Some labels are used as satellite markers ("pseudo satellites") too (see chapter 3.c). 
 
If you click on a label in the label list, all transponders and channels that belong to this label, are 
shown in their list. 
 
To assign one or more channels to a label, please select this/these channels and move it/them with 
drag&drop to the label. If you reach the border of the label list, the list is scrolled automatically in this 
direction. 
 
If you click with the right mouse button into the label list, you get the following popup menu: 
 

 
 
With Change name you can change the name of a label, alternatively you can hit the return button on 
your keyboard or make a double click on the label. You get a window, where you can change the 
name of the label, and enter if this label should only appear in one channel list (TV or radio) or in both 
lists. 
 
With Change LT Sat (0) and Change LT Vsec (0) you can change the LT8700 parameters (see 
chapter 3.c). The numbers in brackets show the actual values. 
 
With View sorted by the label list can be shown in original order or sorted alphabetically. 
 
With New you can create a new label. You get a window, where you can enter a name for the new 
label, and if this label should only appear in one channel list (TV or radio) or in both lists. 
 
With Delete you can delete a label. If this label contains channels, you are asked if you really want to 
delete this label with all its channels. 
 
Change LNB: With this function you can change the LNB settings (DiSEqC and 0/12 V) for all 
channels of a selected label or pseudo satellite (see chapter 3.c). 
 
To change the order of labels in the label list, just move the labels with drag&drop or, if you keep the 
button Ctrl pressed, with the arrow keys, "Home" and "End" on your keyboard. 
 



Above the label list you find some uppercase letters for the following functions: 
 
F: If you want to move many channels in the same label, it may help to "fix" the label list. I.e. the label 
list does not jump automatically to the label of a new selected channel any more. 
S: The label of a new selected channel is shown automatically in the label list again. 
O: Show labels in original order. 
N: Show labels sorted by names. 
 



  
5.e Transponder functions 
  
 
In the DVB2000 there are no transponder lists in the settings. The transponder data (frequency, 
symbol rate, etc.) are saved for every channel separately. If you want to compare your channel lists 
with Internet lists, it is easier, if you can see all channels of a transponder, because these Internet lists 
are often sorted by transponders. So, in SetEditDVB2000 a transponder list is created. For this the 
transponder data of all channels are compared and all channels with the same transponder data are 
assigned to one transponder. 
 
If you select a transponder only the channels that belong to this transponder are shown. 
 
You get most functions if you click with the right mouse button on the transponder list. You will get the 
popup menu of the transponder list. 
 

 
 
With View sorted by you can select if the transponders are displayed in their original order or sorted 
by frequency or polarity. The transponders will remain in the original order internally. 
 
With Sort you can sort the transponder list by frequencies or polarities. With this function you also 
change the internal order off the transponders. 
 
With Change data you can change the parameters of a selected transponder. You get the following 
window: 
 

 
 
You can also call this function with a double-click on a transponder. Here you can change the 
frequency, the polarity, the symbol rate, the FEC and the Net ID of a transponder. These changes 
are made for all channels that use this transponder too. 
 
With Delete you can delete a transponder and all its channels. You can also use the Del key on your 
keyboard. If the transponder has channels, you are asked if you really want to delete these channels. 
If you want to delete a transponder without checking if existing channels are deleted too, you can use 
the shortcut Ctrl-Del. 
 
With Scan transponder the receiver will search all channels that are on the selected transponder. 
 
With New -> TV/Radio channel on this transponder you can create a new channel on a selected 
transponder. You get the same window as for the function "New" of the popup menu of the channel 
list, but now the transponder data is already entered. 
 
In the frame of the transponder list there are several uppercase letters for the following functions: 
 
O: The transponders are shown in original order. 
F: The transponders are shown sorted by frequencies. 
P: The transponders are shown sorted by polarities. 
 



  
5.f Favourites 
  
 
The DVB2000 has one favourite list into which you can copy your favourite channels. 
 

 
 
When you click with the right mouse button in the favourite list, you get the following menu: 
 

 
 
With Export you can save a selected FAV list. 
 
With Import you can load a previously saved FAV list. 
 
Channels that are in the FAV list are marked in the channel list with a darker background colour. 
(You can change these colours in the configuration.) 
 
Add/remove a channel to/from the FAV list: 
To add one or more channels to the FAV list, please select the channel(s) you want to add to the FAV 
list. Now you can drag them to the FAV list (drop them on the name of the list). They are added at the 
end of this FAV list. 
To remove a channel from the FAV list, please select the FAV list and then the channel that you want 
to remove from the favourite list and use the delete function of the channel list menu or hit the Del key 
on your keyboard. If you delete a channel within the FAV list, this channel is only removed from the 
FAV list and not from the main list. 
It is also possible to assign one or more channel(s) to the FAV list or remove them from the FAV list 
with the help of the "Mark as" function in the channel list menu. 
 
Change channel order within a FAV list: 
To change the order of the favourite channels, please select the channel(s) you wish to move. Now 
you can drag them to the position within the FAV list where you want to have them (drop them on the 
new position). 
 
Within the favourites you can change the order independently of the order in the main list. If you now 
change the order by using the drag & drop function you will only change the order within the FAV list 
but not the order of the main list. In the opposite way the order of the channels in the FAV list will not 
change, if you change the order of the channels in the main list. 
 
It is possible to move labels from the channel list into the FAV list to have markers in the FAV list too, 
on which you can jump with your remote control. 
 
Note: If you have a DVB2000 version lower than 2.00, you can't jump on these markers in the FAV list 
with your remote control. 
 
If you don't find the channels you expect in the favourite list after writing your settings into the receiver, 
you have probably entered the wrong DVB2000 software version in the configuration of 
SetEditDVB2000 (see chapter 5.b). 
 
Note: It is not possible to change the name of the FAV list; it is hard coded in the receiver. 
 



  
6 Problems 
  
 
If you have problems with the serial connection please check your serial cable. It has to be a serial 
null-modem cable (no 1:1 cable) with the following pin connections: 
 
2-3 
3-2 
4-6 
6-4 
5-5 
7-8 
8-7 
 
SetEditDVB2000 is only tested with the original version of the receiver firmware. If you have changed 
the receiver firmware, I can't guarantee that the program will work properly. 
 
If you use a serial connection, the same serial speed (baud rate) has to be set in SetEditDVB2000 and 
in the receiver (Menu -> 9 -> A -> 6). 
 
If you use a SCSI interface, an ASPI driver has to be installed on your PC (you find such a driver for 
example on www.adaptec.com). For some Windows versions you have to install a DVB2000 (pseudo) 
driver, too. You find such a driver for example on www.gkware.com/dvb2000. 
 
The receiver can handle up to 3071 channels. These channels can be read from the receiver without 
problems, but if you use a serial connection you can only write up to 2047 channels into the receiver. If 
you try to write more than 2047 channels in your receiver via the RS232 interface you get an error 
message. 
 
If you change the receiver software via the RS232 interface and depending on your flash memory, it 
may happen, that the receiver does not reboot any more (the display stays dark). Please don't panic! 
You only have to unplug the main plug and plug it in again. 
 
If you use a DVB2000 version 2.0 or higher, the following functions will not work properly: "Test" and 
"Scan transponder". In both cases the tuner cannot be switched to the requested transponder data 
and PIDs, because the buggy auto PID function overwrites these parameters immediately. For the " 
Scan transponder" function it may help, if you switch the receiver on a channel with the required 
transponder data before you start scanning. The scan function will then find the channels, but you 
can't test them. 
 
If you don't find the channels you expect in the favourite list after writing your settings into the receiver, 
you have probably entered the wrong DVB2000 software version in the configuration of 
SetEditDVB2000 (see chapter 5.b). 
 
In some of the menus in the receiver you will find letters (A-F) that you don't find on your remote 
control. If you have got a dBox remote control, you have to press "Mark" for A, "Opt." for B, "Info" for 
C, "+" for D, "-" for E and "Mute" for F. If you have a Nokia remote control (Nokia 9200, 9500, 9600), 
you have to press "Menu" for A, "Exit" for B, "Info" for C, "+" for D, "-" for E and "Mute" for F. 
 
If you have any other problems please feel free to contact me by e-mail. Please note for all problems 
the exact version of SetEdit you use (see Help -> About SetEditDVB2000). 
 
My e-mail address is Wolfgang.Litzinger@setedit.de 
 
Please don't call me to tell me about problems. There is no phone support. 
 



  
7 Register 
  
 
You can get your registration key for 16,99 € from me. I need your full name and your e-mail address. I 
can't send you the registration key by post. 
 
In the demo version you can only change 20 channels. After this you can neither save your settings 
nor write them into your receiver. 
 
Note: Without your e-mail address and your full name I can't register you for SetEditDVB2000.  
 
To register for SetEditDVB2000 there are 4 possibilities: 
 
1. You send me the money in cash (by registered letter). 
 
My address is: 
Wolfgang Litzinger 
Frontalstr. 42 
67693 Fischbach/Germany 
 
2. You can make a direct money transfer. 
 
Note: If you transfer from outside Germany please make sure that you pay the fees for international 
money transfer. 
 
My account is: 
Account number 44 609 52 00 
Bank name: Bank 24 
Sort code: 380 707 24 
Bank address: 
P.O. box 24 
Karl-Legien Str. 188 
53244 Bonn/Germany 
SWIFT: DEUT DEDB XXX 
IBAN: DE66 3807 0724 0446 0952 00 
 
Please use as the reason for payment your name, the editor version you wish to order and add a 
random number (e.g. your zip code, phone number etc.). 
Example for a reason for payment: Charles Brown SetEditDVB2000 12:56 
 
Please send me an e-mail when you have transferred the money. The body of the mail should contain 
your name, the editor version you wish to order (here SetEditDVB2000) and the random number you 
wrote in the reason for the money transfer. 
 
Example for an e-mail text: Order for SetEditDVB2000, Charles Brown, 12:56 
 
Please check if you e-mail address is valid (e.g. by sending an e-mail to your own address). 
Unfortunately it happens sometimes that I want to send someone an e-mail with the registration key 
but the e-mail comes back undeliverable because the return address is not correct. 
Please make sure that your name is in the e-mail (there are often e-mails like "from: 
superman@aol.com, I have sent you money today please sent me the editor"). In this case I can't 
relate your mail with my bank account. 
Please don't try to write your e-mail address to the reason of the money transfer, special characters 
like "@" and "_" are not valid for this. 
 
Please don't sent me pictures of your transfer sheet or online banking program, you will get the 
key as soon as I have the money on my bank account, I check my account every day. 
 
If you get no e-mail from me after 7 working days, please contact me by e-mail. Either I could not 
assign your money transfer to someone or something is wrong with your e-mail address. 



 
3. The easiest way to pay from outside Germany is to pay by credit card (Visa/MasterCard or 
American Express). Please use the order form on the next page, print it and fill out all fields and then 
send it to me by fax +49 (0) 32 212369299. 
 
4. You can also use the online shop on my homepage to pay by Visa/MasterCard. 
 
 
Back to Contents. 
 



  
Order for SetEditDVB2000 
  
 
(Please write in block letters, faxes are often hard to read!) 
 
Date: _________________ 
 
From: 
First name: ___________________________ 
 
Last name: ___________________________ 
 
E-mail:  ___________________________ 
 
 
Note: if you don't get a reply within 3 working days I couldn't read your mail address or the address 
was not valid, please sent me a mail so I can see your correct mail address. 
 
Street:  ___________________________ 
 
ZIP code: ___________________________ 
 
City:  ___________________________ 
 
Country: ___________________________ 
 
Fax:  ___________________________ 
 
To: Wolfgang Litzinger 
 
Company: SetEdit 
 
Fax number: +49 (0) 32 212369299 
 
 
  Visa/MasterCard     American Express 
 
Card number: _ _ _ _-_ _ _ _-_ _ _ _-_ _ _ _  3 _ _ _-_ _ _ _ _ _-_ _ _ _ _ 
 
Expire date: _ _/_ _ 
 
I have tested the demo version of SetEditDVB2000 successfully and allow you to charge 16,99 Euro 
from my credit card. 
 
 
Signature: ____________________ 
 



  
8 Glossary and abbreviations 
  
 
Baud rate: The speed at which data is transferred via the serial port to the receiver. The number is in 
bits per seconds. 
 
Decimal/Hexadecimal: Hexadecimal is a system for representing numbers in base 16, rather than the 
base 10 we normally use. The hexadecimal system requires 15 digits and a zero; conventionally the 
letters A-F are used to represent the digits for that the decimal system cannot provide equivalents. 
Hexadecimal notation is not usually important for the PC user (with the possible exception of 
specifying base addresses) but is still quite important for the programmer. Its importance arises 
because there is a very close correspondence between hexadecimal and the very important binary 
numbering system that computers use internally. However, hexadecimal notation is much more 
compact than binary. 
The reason why you can select both systems in SetEdit is that many satellite operators use "even" 
hexadecimal PID numbers. For example the audio PIDs on Astra transponder 11720 are in decimal 
notation 256, 512, 768, 1024, 1280 etc., whereas in hexadecimal notation they are 100, 200, 300, 400 
etc. 
 
DLL: Dynamic Link Library. A Windows library file that can be shared by multiple applications. 
 
FEC: Forward Error Correction. A system, in which redundancy is added to the message so that most 
errors can be corrected dynamically at the receiver. Usual values are 1/1, 1/2, 2/3, 3/4, 5/6 and 7/8. 
3/4 means that 3 out of 4 bits are reference data and the remaining one is for error correction. 
 
LNB: Low Noise Block (converter). Amplifies received signals and converts them from microwave to 
lower frequency signals that are then sent along a cable to the satellite receiver. An LNB can be either 
single or double. A double LNB is required when more than one receiver is used allowing the viewing 
of different satellite channels on other television sets. 
 
PID: Program Identifier. A 13-bit code in the transport packet header. PID 0 indicates that the packet 
contains a PAT PID. PID 1 indicates a packet that contains CAT. The PID 8191 (all 1 bits) indicates 
null (stuffing) packets. All packets belonging to the same elementary data stream have the same PID. 
The most important PIDs are the Video PID (for the video information), the Audio PID for the sound 
and the PCR PID (Program clock reference) to get Video and audio synchronous. 
If you enter an existing Service ID for a channel, the receiver can get all necessary information for this 
channel. If you only enter the video and the audio PID, it may happen that you see the picture and 
hear the sound, but EPG does not work because this information is transmitted on a different PID. 
Usually the receiver finds the PIDs automatically, but occasionally (exotic channels) you have to know 
them and enter them by hand. 
 
Symbol rate: The amount of digital data that is transmitted per second via a transponder. This is 
specified in Msymb/sec (Mega symbols per second), whereby a "Symbol" consists of 4 bits. The 
symbol rate together with the FEC value can be used to calculate the bandwidth of a transponder. 
 
Polarity: A satellite transmission signal has either a vertical, horizontal, or circular orientation; a 
satellite can be all vertical or all horizontal; if a satellite is cross polarised, it can transmit both ways 
and therefore has twice the delivery capacity. 
Besides the horizontal and vertical polarisation we also find the circular polarisation. Circular 
polarisation is not as easy to understand as linear polarisation, you can imagine that the waves are 
rotating clockwise or anticlockwise. In this case we speak about LHC and RHC (left hand circular and 
right hand circular). 
As a rule in Europe linear polarisation (horizontal and vertical) is used. In Scandinavia and for C-band 
reception circular polarisation is used. 
 
Select: To select a channel please click with the mouse on the channel. To select more than one 
channel you can use the usual windows methods. 
When you press the shift key and click on a channel all channels between the currently selected and 
the last selected channel are selected. 
If you press the Ctrl key on the keyboard you can add single channels to your selection. 



 
Settings are the part of the memory of your receiver where all channel information is stored. 
It contains all channel information such as sequence, channel name, frequency, symbol rate, FEC, 
and all other parameters. 
 
 


